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ABSTRACT 

 

The DICE model, constructed by William Nordhaus, is a global carbon emissions projection 
model that integrates economics, carbon cycle, climate science and damage in an IAM 
(Integrated Assessment Model). Although there is no consensus about the discount rate (pure rate 
of time preference) of IAM, determining the optimal discount rate would be a crucial step in 
feasible carbon emissions cost-benefit analyses. I adapted 2013 version of Dynamic Integrated 
Climate Economy Model (DICE) in order to: 1) project global carbon emissions from 
2010~2100; 2) assess damage costs as the result of carbon emissions; 3) calculate the social cost 
of carbon from marginal damage costs; 4) optimize discount rate by superimposing with 
Representative Concentration Pathways (RCP) 4.5 scenario 5) find the optimized emission 
control rate and finally, 6) conduct cost-benefit analysis to determine if the optimal discount rate 
passes the test. I found that the optimal emission control rate increases as pure rate of time 
preference (PRTP) decreases. As a result, the global temperature increase from pre-industrial 
level over time is greater for higher PRTP scenario than the lower ones do. The cost- benefit 
analysis demonstrated that the optimal PRTP was 3%. A small change in PRTP significantly 
changed the global emission control rate and temperature increase. I conclude that determining 
the optimized PRTP is an important step in constructing an accurate and financially feasible 
global carbon emission projection model.  
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INTRODUCTION 

 

Global climate change due to anthropogenic carbon emissions has already had significant 

effect on the environment. The global temperature is expected to rise by 2.5 ℃ by 2100 (IPCC 

2013). In response to the rapidly changing global climate, governments are setting emission 

reduction targets by 2050 as Intended Nationally Determined Contributions (INDC) in United 

Nations Framework Convention on Climate Change (UNFCCC). The major challenge in 

determining global level emission target is assessing the effect of carbon emissions on global 

temperature increase. Oftentimes, carbon emissions are greatly related to economic growth and 

welfare of the population. Many empirical researches found strong correlation between amount 

of carbon emissions and economic growth rate/GDP of a nation (Ansuategi and Escapa 2002). 

China for example, had the largest increase in carbon emissions in the last 20 years because the 

economic growth rate and population grew rapidly. Most of economic growth was the result of 

fossil fuel consumption. Thus, aggressively reducing the greenhouse gas emissions implies 

slowing of economic growth in carbon-intensive nations (Netherlands Environmental 

Assessment Agency 2016). Certainly, the economic component plays a large role in emissions 

targets. Thus, an integrated climate model that factors both climate science and economic 

component is necessary to determine global emissions target.  

Dynamic Integrated Climate-Economy (DICE) model incorporates economics, carbon 

cycle, climate science and impacts in a highly aggregated model that allows a weighing of the 

costs and benefits of a specific emission target (Newbold 2010). The model can 1) project the 

effect of carbon emissions on global temperature increase 2) find optimized welfare function 3) 

determine optimal emission control rate and 4) conduct cost-benefit analysis of a climate policy 

with a specific emission target. The major components of DICE includes: 1) carbon cycle model 

2) economic model 3) welfare function and 4) radiative forcing model. By integrating various 

quantified components of climate science with economic model, policy makers can estimate the 

optimal emission target scheme, which is financially feasible and environmentally friendly. 

Focusing on the economic component of DICE model, welfare function is one of the 

most significant factors in cost-benefit analysis, which weighs the abatement cost and benefits of 

reducing carbon emissions in terms of dollar value. In this study, I tried optimize the discount 

rate in welfare function. Welfare function is a component of DICE model that determines 
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happiness of population. From purely economists’ perspective, I assumed more consumption 

(more money) leads to more happiness. Thus, the ranks of social states directly correlate with 

more consumption (Amartya 1970). The main objective of my study is finding the optimal 

welfare function and determining emission control rate.  

Emissions control rate is the fraction of emissions that are reduced or controlled by a 

climate change policy. For example, if a climate change policy limits emissions to 80% of 

business as usual cases, the control rate is 20% (University of Chicago). Business as usual 

scenario is where there are no controls on emissions of CO2, or the emissions control rate is 

zero. When a carbon emissions climate policy mandates a certain emissions reduction, The DICE 

or (Integrated Assessment Model) IAM interprets emission control rate and converts to economic 

costs/benefits.  

In addition to emissions control rate, discount rate is an important component in welfare 

function. To determine how much we should spend to mitigate climate change, economists need 

to consider the upfront costs and future costs. The discount rate is used to determine the present 

value of future cash flows (Rehmeyer 2010). Because the future cost is valued differently than 

present upfront costs, discount rates factor in the opportunity cost of saving money in the future 

and total value of all future cash flows (both inflowing and outflowing) (Wall Street Oasis 2017). 

There are two different types of discount rates, constant and pure rate of time preference (ptrp). 

Constant discounting rate depreciates future value of the money at a constant rate. Pure rate of 

time preference incorporates Ramsey discounting, which factors in welfare function (Anthoff 

2016).  

 
METHODS 

 

Part 1: Modeling a climate dynamics model 

 

The input (or forcing) to the climate dynamics model was yearly atmospheric CO2 

concentrations, measured in ppm. The output of the climate dynamics model was the yearly 

average temperature increase over pre-industrial temperatures in °C. The forcing to the climate 

dynamics model was provided in the pre existing Excel file from Dr. Anthoff. The model ran in 

yearly time steps, and will start in the year 2010 and run to the year 2100 (Anthoff 2016).  
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𝑡𝑡 

𝑡𝑡 

𝑡𝑡 

Climate Dynamics Model 

 

The climate dynamics model I built has two parts: the first part computed how much extra 

energy is warming the atmosphere due to climate change and what the long term temperature effect 

of that extra energy would be. The second part computed the predicted yearly global average 

temperature increase over time. 𝑟𝑟𝑟𝑟𝑡𝑡
𝐶𝐶𝐶𝐶2  is the amount of extra energy caused by rising CO2 

concentrations (W/m2). The equation to compute 𝑟𝑟𝑟𝑟𝑡𝑡
𝐶𝐶𝐶𝐶2 is:  

 

𝑟𝑟𝑟𝑟𝑡𝑡
𝐶𝐶𝐶𝐶2 = 5.35𝑙𝑙𝑙𝑙

𝐶𝐶𝑡𝑡
𝐶𝐶𝑝𝑝𝑝𝑝𝑝𝑝

 

 

𝐶𝐶𝑡𝑡 is the atmospheric CO2 concentrations at point 𝑡𝑡 in ppm. 𝐶𝐶𝑝𝑝𝑟𝑟𝑝𝑝 is the pre-industrial level of 

atmospheric CO2 concentrations. Other greenhouse gases also causes global warming by 

increasing radiative forcing. I integrated the forcing caused by other greenhouse gases as a forcing 

that was supplied to me as part of this baseline data sheet (Anthoff 2016). I referred the radiative 

forcing of other greenhouse gases as 𝑟𝑟𝑟𝑟𝑜𝑜𝑡𝑡ℎ𝑝𝑝𝑟𝑟. The total effect of global warming with all 

radiative forcing was computed as: 

𝑟𝑟𝑟𝑟𝑡𝑡 = 𝑟𝑟𝑟𝑟𝑡𝑡
𝐶𝐶𝐶𝐶2 + 𝑟𝑟𝑟𝑟𝑡𝑡

𝐶𝐶𝑡𝑡ℎ𝑝𝑝𝑝𝑝 

 

The next step in the model was to compute the warming that would occur if a given level of 

radiative forcing lasted for a long period of time. The equation is: 

𝑇𝑇𝑡𝑡𝑝𝑝 = 𝜆𝜆 × 𝑟𝑟𝑟𝑟𝑡𝑡 

𝑇𝑇𝑡𝑡𝑝𝑝 is the increase in global average surface temperature over pre-industrial levels if the radiative 

forcing of 𝑟𝑟𝑟𝑟𝑡𝑡 were to be held constant for a very long time. 𝜆𝜆 is the climate sensitivity, which 

was set to 0.8 (Rahmstorf 2008).  

 The final step was to compute the actual temperature for each time step. I used a very 

simple delay formulation. I assumed that the actual temperature would warm by a very small 

fraction of this computed difference. The equation for this process is: 

𝑇𝑇𝑡𝑡 = 𝑇𝑇𝑡𝑡−1 + 𝜇𝜇(𝑇𝑇𝑡𝑡𝑝𝑝 − 𝑇𝑇𝑡𝑡−1) 
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 𝑇𝑇𝑡𝑡 is the global average temperature increase above pre- industrial times in °C at time 𝑡𝑡. 

𝜇𝜇 is the parameter that controls the delay of the warming, which is 1/60 (Rahmstorf 2008). 

 

Part 2: Carbon cycle model 

  

 I built a carbon cycle model and coupled it with the previously built climate dynamics 

model. The inputs to the carbon cycle model were yearly emissions of CO2, measured in Mt C. 

The output of the carbon cycle model was atmospheric concentrations of CO2, measured in ppm. 

The two components are coupled via the atmospheric concentration of CO2, i.e. the output of the 

carbon cycle model is an input to the climate dynamics model.  I found the excel data file for the 

forcing to the carbon cycle model (IPCC 2009).  

The carbon cycle model consisted of a simple five-box model. Over time, each individual 

box reduces CO2 at different rates. On the other hand, the boxes account for new anthropogenic 

CO2 emissions for each year into the atmosphere. In the five-box model, the fixed shares of the 

five boxes were: 13% percent went into the first box, 20% into the second, 32% into the third, 

25% into the fourth and the remaining 10% into the fifth box (Anthoff 2016).  

The five variables represented the five boxes and each of these variables took on a different 

value in each year. The equation that was used to compute the amount of CO2 in box 𝑖𝑖 (which 

took values from 1 to 5) at time 𝑡𝑡 (which takes on value from 2010 to 2100) was: 

𝐵𝐵𝑜𝑜𝐵𝐵𝑖𝑖,𝑡𝑡 = 𝑎𝑎𝑖𝑖 × 𝑏𝑏𝑜𝑜𝐵𝐵𝑖𝑖,𝑡𝑡−1 + 𝛾𝛾𝑖𝑖𝛽𝛽𝐸𝐸𝑡𝑡 

𝐵𝐵𝑜𝑜𝐵𝐵𝑖𝑖,𝑡𝑡 was the amount of CO2 in box 𝑖𝑖 at time 𝑡𝑡, measured in ppm. 𝛼𝛼𝑖𝑖 was the share of CO2 in 

box 𝑖𝑖 that stayed in the atmosphere until the next time period (so 1 − 𝛼𝛼𝑖𝑖 is the share of CO2 that 

disappears each year from box 𝑖𝑖). 𝛾𝛾𝑖𝑖 was the share of emissions that went into box 𝑖𝑖. 𝛽𝛽 was a unit 

conversion factor: CO2 emissions in our model were measured in Mt C, but atmospheric CO2 

concentrations were measured in ppm; 𝛽𝛽 converted from the unit Mt C to CO2 ppm. 𝐸𝐸𝑡𝑡 were 

world total emissions of CO2 in year 𝑡𝑡, measured in Mt C. I used initial values for each of the five 

boxes that are provided below as 𝐵𝐵𝑜𝑜𝐵𝐵𝑖𝑖,2010 (Tol 2014). The final step in the carbon cycle model 

was to compute atmospheric CO2 concentrations at each point in time: 

𝐶𝐶𝑡𝑡 = �𝐵𝐵𝑜𝑜𝐵𝐵𝑖𝑖,𝑡𝑡 = 𝐵𝐵𝑜𝑜𝐵𝐵1,𝑡𝑡

5

𝑖𝑖=1

+ 𝐵𝐵𝑜𝑜𝐵𝐵2,𝑡𝑡 + 𝐵𝐵𝑜𝑜𝐵𝐵3,𝑡𝑡 + 𝐵𝐵𝑜𝑜𝐵𝐵4,𝑡𝑡 + 𝐵𝐵𝑜𝑜𝐵𝐵5,𝑡𝑡 
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𝑡𝑡 

𝑡𝑡 

𝐶𝐶𝑡𝑡 is the atmospheric concentration of CO2 at time 𝑡𝑡, was simply the sum of the five boxes at 

that time. 

 

Part 2-1: Coupling 

 

To couple the climate dynamics model with the carbon cycle model, I replaced the values in the 

row that had the CO2 concentration forcing in the climate dynamics model with a formula that 

references the output from the carbon cycle model. 

 

Part 3: Emissions model 

 

I added a component that computes anthropogenic CO2  emissions over time to the previously 

built model. I coupled the carbon cycle component to the emissions component. The new 

component will rely on the emissions component, which had Kaya identity: 

𝐸𝐸𝑡𝑡,𝑘𝑘𝑘𝑘𝑘𝑘𝑘𝑘 = 𝑃𝑃𝑡𝑡(
𝑌𝑌𝑡𝑡
𝑃𝑃𝑡𝑡

)(
𝐸𝐸𝑙𝑙𝑝𝑝𝑟𝑟𝐸𝐸𝐸𝐸, 𝑡𝑡

𝑌𝑌𝑡𝑡
)(

𝐸𝐸𝑡𝑡,𝑘𝑘𝑘𝑘𝑘𝑘𝑘𝑘

𝐸𝐸𝑙𝑙𝑝𝑝𝑟𝑟𝐸𝐸𝐸𝐸, 𝑡𝑡
) 

 

𝐸𝐸KAYA was industrial CO2 emissions in Mt C at time 𝑡𝑡, 𝑃𝑃𝑡𝑡 was population at time 𝑡𝑡, 𝑌𝑌𝑡𝑡 was 

output (or GDP or income) at time 𝑡𝑡 and 𝐸𝐸𝑙𝑙𝑝𝑝𝑟𝑟𝐸𝐸𝐸𝐸𝑡𝑡  was energy use in EJ (exajoule) at time 𝑡𝑡 

(IPCC 2013). The forcing for population was provided as the initial level for 2010, and then 

yearly growth rates of population for all future years. The initial population level for 2010 was 

6900 million people. Growth rate was given as well (IPCC 2013). The initial level of per capita income 

in 2010 was 8.5 thousand dollars per capita. For later years I needed to compute the levels from 

the yearly growth rate of per capita income that was provided as a forcing (IPCC 2013). The 

initial level of energy intensity for the year 2010 is 5.98 EJ per trillion $ of output. For years later 

than 2010, the yearly growth rates of energy intensity were given (IPCC 2013). The initial level 

of carbon intensity was 18.62 Mt C per EJ of energy for the year 2010 (IPCC 2013). I needed to 

use the growth rate of emission intensity provided as a forcing to compute the carbon intensity 

for future years. 

 At this point I computed emissions from industrial activities in business as usual 

scenarios. Another source of anthropogenic CO2 emissions that I included as an extra forcing 
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was land use emissions𝐸𝐸𝐿𝐿. This category mostly covered extra emissions caused by deforestation 

(IPCC 2013). Total business as usual (BAU) emissions were therefore given as: 

𝐸𝐸𝑡𝑡𝐵𝐵𝐵𝐵𝐵𝐵 = 𝐸𝐸𝑡𝑡𝑘𝑘𝑘𝑘𝑘𝑘𝑘𝑘 + 𝐸𝐸𝑡𝑡𝐿𝐿 

 

Part 3-1: Coupling 

 

 Finally, I coupled the carbon cycle component with the emissions component. Instead of 

using a forcing for the carbon cycle, I coupled with the emissions computed in the emissions 

component. 

 

 

Part 4: Emission Reduction Option 

 

 To model ‘Emission Reduction Option’, I added a choice variable: the emission control 

rate. The emission control rate computed the amount of CO2 emissions per year we need to 

reduce. For business as usual scenario, I initially set the control rate to 0% (i.e. no climate 

policy). Later in part 8, I returned and adjusted emission control rate using excel optimization 

software. Meanwhile, I designated the emission control rate, 𝜇𝜇𝑡𝑡. The new final equation for 

emissions therefore was:  

𝐸𝐸𝑡𝑡 = (1 − 𝜇𝜇𝑡𝑡)𝐸𝐸𝑡𝑡𝐵𝐵𝐵𝐵𝐵𝐵 

Now I coupled the carbon cycle model to this new variable 𝐸𝐸𝑡𝑡. To calculate the size of this 

burden, also called abatement cost, I used a simple cost function: 

Λ𝑡𝑡 = 𝛽𝛽1,𝑡𝑡𝜇𝜇𝑡𝑡𝛽𝛽2 

Λ𝑡𝑡 was the cost of climate policy at time 𝑡𝑡 as a share of GDP at the time 𝑡𝑡, 𝛽𝛽1,𝑡𝑡 was a parameter 

that changes over time and 𝛽𝛽2 is another parameter that was set to 2.8. I added another row for the 

variable Λ𝑡𝑡 to your model. Finally, in addition to Λ𝑡𝑡, I added one more variable to the Excel 

sheet that computed the cost of climate policy in trillion dollars for each year (Nordhaus 2013).  
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𝑡𝑡 

Part 5: Growth Model 

 

I added a component that computes economic growth to the previous model. The new 

growth component computed output, or GDP, which was an input into the emissions component. 

The new growth component required an exogenous forcing (Anthoff 2016).  

I built a Solow-growth model that computes GDP. Output in a specific year was computed by a 

production function in the Solow model that depended on three things: the amount of capital (in 

dollars), the amount of labor (population size) and a technology index or total factor productivity, 

which measured how efficient we use capital and labor to produce GDP. I used a Cobb-Douglas 

production function and had the following form: 

𝑌𝑌𝑡𝑡𝐺𝐺 = 𝐴𝐴𝑡𝑡𝐾𝐾𝑡𝑡𝛼𝛼𝑃𝑃𝑡𝑡1−𝛼𝛼 

𝑌𝑌𝐺𝐺  was gross output in trillion dollars. 𝐴𝐴𝑡𝑡 was the total factor productivity. 𝐾𝐾𝑡𝑡 was the amount 

of capital at time 𝑡𝑡 available for production, measured in trillion dollars. 𝑃𝑃𝑡𝑡 was population in 

million at time 𝑡𝑡, and 𝛼𝛼 was called the capital share, set to 0.3 (Nordhaus 2013). Gross output did 

not account for the cost of climate policy. The equation for net output included abatement costs 

and was given as: 

𝑌𝑌𝑡𝑡 = (1 − Λ𝑡𝑡)𝑌𝑌𝑡𝑡𝐺𝐺 

So the equation picked up the effect of the control variable from the emission abatement 

component I added in the previous section.  

 When modeling the capital stock I assumed that there was an inflow of new capital (i.e. 

new industrial complex and machines) and that some capital breaks over time, so there was an 

outflow of capital, which was sunk cost. The equation of motion for the capital stock was given 

as: 

𝐾𝐾𝑡𝑡 = (1 − 𝛿𝛿)𝐾𝐾𝑡𝑡−1 + 𝐼𝐼𝑡𝑡−1 

𝛿𝛿 was called the depreciation rate of capital and was set to 10% per year (so the value would be 

0.1). 𝐼𝐼𝑡𝑡 was the investment rate. The initial value was 139.65 trillion dollars (Nordhaus 2013).  

The amount of new investment into capital for year 𝑡𝑡 was modeled as: 

𝐼𝐼𝑡𝑡 = 𝑠𝑠𝑌𝑌𝑡𝑡 

𝑠𝑠 was called the savings rate, and was fixed to 22% (Anthoff 2016).  
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Part 5-1: Coupling 

 

 I coupled the emissions component with the growth component. First, I modified the 

equation for the Kaya identity. GDP entered the Kaya identity via output per capita, the second 

factor in the Kaya identity. The Kaya identity in our model told us how much emission there would 

be if no climate policy were in place. Therefore, I linked the Kaya identity to gross output from 

the growth model. I made sure to convert gross output into gross output per capita in order to be 

consistent with units. Finally, since variables in abatement cost model depends on GDP, and 

coupled this with gross output from the growth model. 

 

Part 6: Impact Model 

 

 I added a component for the impacts of climate change to the model. I modified the 

growth model to account for the estimate of climate impacts. We assumed that the damage done 

from rising temperatures in a given year as a share of gross output was: 

𝐷𝐷𝑡𝑡 = 𝜓𝜓𝑇𝑇𝑡𝑡2 

So 𝐷𝐷𝑡𝑡 is damage as a share of gross output in GDP at year 𝑡𝑡, 𝜓𝜓 is a parameter set to 0.003 and 𝑇𝑇𝑡𝑡   

was global average temperature in °C above pre-industrial levels at time 𝑡𝑡 (Nordhaus 2013). I 

coupled with the temperature from the climate dynamics component. 

 

Part 6-1: Growth Model 

 

To close the loop, I linked the equation for net output in the growth model to account for the 

costs of abatement from gross output and the damages from climate change. Then I added two 

new variables: consumption (in trillion dollar) and per capita consumption (in dollar per person). 

The equation for consumption was gross output minus the costs of abatement, the damages from 

climate change and investment in the capital stock. To compute per capita consumption I divided 

consumption by population (Nordhaus 2013).  
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Part 7: Social Cost of Carbon  

 

Social cost of carbon (SCC) was the net present value of the impact caused by an extra 

emission of 1 ton of carbon today (IPCC 2013). To compute the SCC, first, I set up a base run at 

year t, which was identical to the previous model setup. In the second there was an additional 

emission of 1 ton of carbon into the atmosphere in the year t+1. As a result of extra ton carbon, the 

marginal run would have slightly more warming, and that would cause slightly larger damages from 

climate change. 

Then I computed the difference in damages between the base and marginal run for each 

year in dollars. This was marginal damages-a time series of additional damages caused by one 

additional ton of carbon emitted today (Anthoff 2016).  

The next step was to compute the net present value of marginal damages. I multiplied the 

marginal damages in each year with the discount factor for that year. This gave me a new time 

series of the net present value of marginal damages (Goulder and Williams 2012). The final step 

was to add up the net present value estimates of marginal damages over time. This gave me the 

Social Cost of Carbon (SCC).  

 

Part 7-1: Discount Factor 

 

I used discount factors that are parameterized on a constant discount rate. The equation 

for these discount factors is: 

𝐷𝐷𝐷𝐷𝑡𝑡 =
1

(1 + 𝑟𝑟)𝑡𝑡
 

Here 𝐷𝐷𝐷𝐷𝑡𝑡 was the discount factor for time step 𝑡𝑡. 𝑡𝑡 = 0 corresponded to the year 2010, 𝑡𝑡 = 1 to 

2011 and so on. 𝑟𝑟 was the discount rate and you should initially set it to 3% and was adjusted in 

the latter cost-benefit analysis (Goulder and Williams 2012). 

 

Part 8: Welfare function  

 

I computed the optimal climate policy trajectory over time. First, I added a welfare 

function to the model. Second, I installed a numerical optimization package from Excel and 3) I 
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ran this numerical optimization package to find the optimal policies for a variety of different ptrp 

discount rate cases.  

To calculate the overall social welfare for a given policy, I used the welfare function: 

𝑆𝑆𝑆𝑆𝐷𝐷 = �𝑃𝑃𝑡𝑡𝑙𝑙𝑙𝑙𝐶𝐶𝑡𝑡(
1

1 + 𝜌𝜌
)𝑡𝑡

𝑇𝑇

𝑡𝑡=0

 

 

 

𝑃𝑃𝑡𝑡   was the population size at time 𝑡𝑡 (in million people) and 𝑐𝑐𝑡𝑡  was per capita consumption at 

time 𝑡𝑡 (in $/capita). I coupled these two variables from the previous economics model. 𝜌𝜌 was the 

pure rate of time preference, and 𝑇𝑇 was the time horizon of my model. 

 

Part 8-1: Preparing the model 

 

 Previously constructed model could set a different mitigation level (emission control rate) 

for each year of our analysis. This amounted to 291 decision variables for each corresponding 

year time span of the model. In order to find the best value for each of these decision variables, I 

used the numerical optimization package. Because of the limited computing power, I divided 291 

variables into 10 decision variables with each variable’s life span of a decade.  

The first 9 of these stood for the emission control rates for each of the first 9 decades of 

our model (a decade increments like 2010~2019 up to 2100). The tenth decision variable was the 

emission control rate for the years 2100-2300. 

I first created a new row in your Excel sheet that holds these 10 new decision variables. I 

left these variables blank so the solver can find values that maximize the welfare function. The 

existing row for the emission control rate needed to reference the correct cells in this new row. 

For example, the ten cells for the emission control rate in the years 2010-2019 should all 

reference the same one cell in the new row that stands for the decision in the year 2010-2019 

(Anthoff 2016).  

Next, I enabled the numerical optimization package in excel. I followed the general 

instructions from Wabash College’s Introductory Econometrics lecture.  

Here was how to enable it in Excel 2010 for Windows: 

Click on File->Options->Add-Ins 
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Make sure “Excel Add-ins” is selected in the “Manage” field 

Click “Go…” 

Select “Solver Add-in” 

Click “Ok.” 

Here is how you can enable it in Excel 2011 for Mac: 

Click on Tools -> Add-Ins... 

Make sure the box is checked for “Solver.Xlam” in the “Add-Ins available” field 

Click “Ok” 

This adds an item “Solver” under Data->Analysis in the main Excel window, and you can 

start Solver clicking on that new item (Wabash College 2010).  

Next, I told Solver what cell it should try to maximize, and which cells it can modify in 

order to find the best combination of values for the decision variables. I started Solver, and then 

selected the cell with the value for your social welfare function for the “Set Objective” field. 

Next, I selected the range of your ten new decision variables for the field “By changing variable 

cells”. At this point Solver tried to find the combination of values that gives the highest value for 

the cell that I selected as the objective (in this case gives the highest social welfare) (Tol 2014).  

Before I ran Solver, I had to make sure if the range of values that makes sense for the 

decision variables. In our case the decision variables were emission control rates that can take 

values from 0 to 1 (i.e. 0% to 100%). Since I didn’t want emission control rate to be out of these 

range, configured that by setting up constraints in Solver. I added two separate constraints, one 

that said the decision variable always had to be greater or equal to 0, and one that says it always 

had to be smaller or equal to 1. I added two constraints by clicking the “Add” button. In cell 

reference, I selected the same cells as the decision variables, then I selected the correct condition 

(i.e. >= for the first and <= for the second constraint) and finally in the field constraint I added 

either 0 for the first and 1 for the second constraint. The both constraints were listed in the main 

window of Solver in the field “Subject to the Constraints”. Finally, I set the solve method to 

“Evolutionary” and then closed Solver’s windows (Tol 2014).  
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Part 8-2: Run the optimization package 

 

I found the optimal emission control rate for each policy with three different 

specifications of the pure rate of time preference. I created three copies of the base model sheet 

so that each copy could hold the optimal policy for one of the pure rate of time preferences. The 

three rates were ptrp 0.1%, 1% and 3%. 

For each sheet, I ran Solver. The solver generated the 10 decision variable cells to the 

values that maximize the welfare function. 

 The final step was to create two graphs that compared the optimal policies for the three 

pure rates of time preferences. The first graph compared the emission control rate over time for 

the three discount rates. The second graph compared the temperature trajectories for the three 

discount rates over. 

 

Results: I found that emission control rate over time for ptrp .1% scenario was larger than ptrp 

1% or 3% scenario. The optimal emission control rate increases as ptrp percentage decreases 

(Figure 2.1). 

 

 
Figure 2.1. The comparison of the effect of optimized ptrp scenarios on emission control rate over time.  
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Results: I found that temperature increase from pre-industrial level over time is greater for 

higher ptrp scenario than the lower ones do (Figure 2.2) 

 

 
Figure 2.2. The effect of ptrp percentage on temperature increase from pre-industrial level over time.  

 

Part 8-3: Further Analysis: Superimposing derived projections with other studies.  

 

 I compared figure 2.2 with SRES Scenarios and RCPs (Rogelj et al. 2012) and check if 

three optimal prtp scenarios we generated were similar to the pre-existing scenarios.  

 

Results: SRES B1 and RCP4.5 scenarios, which were most likely projections, superimposed 

(with 66% range of probability) with optimal policy with ptrp 3% (Figure 2.3 and 2.4). SRES B1 

scenario also superimposed with both optimal policies with ptrp of 1% and .1% (Figure 2.3). 

Other published scenarios: SRES A1T, B2, A1B, A2, A1F1, RCP 6, RCP 8.5 did not 

superimposed with any of three ptrp % scenarios. They required greater than 3% ptrp (Figure 2.3 

and 2.4). 
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Figure 2.3. Ranges of estimated average temperature increase between 2090 and 2099 for SRES scenarios and 
RCPs respectively. Note that results are given both relative to 1980–1999 (left scale) and relative to pre-industrial 
(right scale). Yellow and thin black ranges indicate results of this study; other ranges show the AR4 estimates (see 
legend at right-hand side). Color-coding of AR4 ranges is chosen to be consistent with the AR4 (see Figure SPM.5 
in ref. 1). For RCPs, yellow ranges show concentration-driven results, whereas black ranges show emission-driven 
results (Rogeli et al. 2012).  

 
Figure 2.4. RCP 4.5 Global Temperature Projections (IPCC 2013).  
 

   

http://www.nature.com/nclimate/journal/v2/n4/full/nclimate1385.html#ref1
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Part 9: Cost Benefit Analysis  

 

I computed the net present value of costs and benefits of the optimized policies in part 8-

2. The costs in this case were the abatement costs of the policy; the benefits were the avoided 

damages. I compared six different discount schemes: a constant discount rate of 2.5%, 3% and 

5% per year, and a ramsey discount rate with a pure rate of time preference of 0.1%, 1% and 3%. 

Then I computed the net present value of abatement costs for a given policy (Figure 2.4), and 

separately computed the net present value of the damages prevented by the policy (Figure 2.5). 

 I listed the net present value of costs and benefits of each of the three optimized policies 

for the six discounting schemes. Finally, I could determine if each policy and discounting 

combination of policies would pass cost-benefit analysis. 

 

Results:  The Optimal prtp .1% CBA passed except in constant discount rate of 3%, 5% 

and ptrp 3%. The optimal prtp 1% CBA passed except in constant discount rate of 5% and ptrp 

3%. The optimal prtp 3% CBA passed (Figure 2.6).  

 

 
Figure 2.4. Cost analysis of optimal prtp policies in six discounts rates. 

 
Figure 2.5. Benefit analysis of optimal prtp policies in six discounts rates. 
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Figure 2.6. Cost-Benefit Analysis of optimal prtp policies in six discounts rates. 

 

Analysis 

 

The optimization of discount factors in welfare function of the IAM (integrated 

assessment model) is an important step in order to accurately calibrate the projected cost-benefit 

of a Greenhouse gas mitigation policy.  If an appropriate discount factor is determined, policy 

makers can set specific emission targets. Using the optimization package in excel, I determined 

that ptrp 3% best fits with the current emissions projection model with (Representative 

Concentration Pathway) RCP 4.5 scenario, the most probably climate scenario (IPCC 2013 and 

Liu et al. 2015). My findings suggest that Ramsey discounting (pure time rate of preference) of 

3% is optimal for the first 100 years of integrated assessment model. In addition, I found that 

optimal 3% ptrp scenario passed the cost-benefit analysis in all discount factors.  

 First, I analyzed the effects of various ptrp-discounting schemes on welfare function of 

optimization package on emission control rates and global temperature increase. Note that this 

discount schemes were only associated with welfare functions necessary to run optimization 

package in excel, not the actual discount rate to calculate net present values in cost-benefit 

analyses. Optimization package is an excel program that determines the optimal emission control 

rate based on the optimized welfare function. 

I observed the effect of discount rate (pure time rate preference) on emission control rate. 

We found that emission control rate over time for ptrp .1% scenario was larger than ptrp 1% or 

3% scenario. The optimal emission control rate increases as ptrp percentage decreases. When I 

ran the optimization package, the IAM (Integrated Assessment Model), interpreted values of 

pure time rate preference as a marginal change in carbon emissions at some future date t. In other 
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words, the greater ptrp percentage value is, lesser the emission control rate would be because 

higher discount rate indicates lower preference of present investment in abatement costs and 

higher preference for spending damage costs due to present carbon emissions (Rahmstorf 2008). 

In graph 3.1, I could observe that emission control rate over time varies greatly with ptrp values. 

Thus, adjusting the optimal ptrp value is a crucial step in determining the optimal emission 

control rates.  

 Next, I observed the effect of discount rate (pure time rate preference) on global 

temperature increase. I found that temperature increase from pre-industrial level over time is 

greater for higher ptrp scenario than the lower ones. Previously, lower optimal ptrp value 

resulted in lower emission control rate. As a result of lower emission control rate, leads to global 

temperature increase. The emission control rate is the fraction of emissions that are reduced or 

controlled by a climate change policy. Higher emission control rate leads to less anthropogenic 

carbon emissions, which deters global temperature increase from greenhouse effect (IPCC 2013). 

Ptrp discount factor is inversely correlated with global temperature increase projections because 

emission control rate is also inversely correlated with discount factor. The ptrp value in welfare 

function greatly influenced emission control rates and global temperature projections.  

 The three leading climate policy evaluations all have greatly variable discount rates and 

implications for the policy. As shown in Table 3.2, the choice of income elasticity, growth factor 

and pure time rate of preference varies greatly in three leading climate policy projections.  

 

 
Table 3.2 Disagreements in pure rate of time preference, income elasticity, growth factor and discount rate in 
three climate policies (Stanford University 2012).  
 

Despite the major disagreements among published projection models, income elasticity 

and growth factors were somewhat in consensus. Thus, in this study, I set income elasticity to 1 

and growth factor to 1.3%. Previously, I adjusted pure time rate of preference in welfare function 

in order to observe the effects of ptrp values on optimized emission control rate and global 

temperature increase. Next, I compared each ptrp .1%, 1% and 3% scenarios’ projected global 
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temperature increase by 2100 with RCP (Representative Concentration Pathways) 4.5 scenario 

where carbon emissions peak by 2050. Many studies revealed that carbon emissions would peak 

by 2050 (Liu et al. 2015). 

 

 
Figure 3.3 RCP 4.5 Global Temperature Projections (IPCC 2013). 

 

 
Figure 3.4 The effect of ptrp values on global temperature increase. 

 
The comparison between my projection model and RCP 4.5 scenario revealed that ptrp 

3% is the most reliable projection model because ptrp 3% scenario aligned with the projected 
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global temperature increase of 2.5 degree Celsius, which was supported by many studies 

including RCP 4.5 from IPCC (IPCC 2013 and Liu et al. 2015).  

 The cost-benefit analyses (CBA) also indicated that the optimal discount rate is 3%. The 

optimization package in excel solved the optimal emission control rate in optimal prtp .1%, 1% 

and 3% scenarios The optimized emission control rate determined the abatements costs and 

social cost of carbon. In order to assess financial feasibility of these three optimal ptrp climate 

policy scenarios, I conducted a comprehensive cost-benefit analysis with three different constant 

and ptrp discounting schemes for each optimal prtp policy. I found that ptrp 3% scenario passed 

the CBA with every discount rate cases.  

 The optimal emission control rate projection model can only generate predictions until 

2100. After 100-year projections, the optimal discount rate must be recalibrated in order to factor 

in new parameters, such as damage costs, changes in emission control rate, income elasticity and 

growth factor. Another caveat of the IAM is the social welfare function assumes more 

consumption leads to higher social utility. The measure of social welfare is debatably highly 

subjective and leads to disagreements as to the appropriate form and parameters of the social 

welfare function (Goulder and William 2012).   

 In order to overcome the limitations of my study, I can conduct more empirical studies to 

measure social preference of consumption and determine more accurate parameters for my 

climate projection model. Rather than relying on the previously established parameters, 

constructing the model from bottom-up approach would eliminate large uncertainties from 

aggravating several components of climate models.   

 The interdisciplinary climate projection model provided crucial knowledge for the future 

climate economists. The ptrp in welfare function played an important role in determining the 

optimal emission control rate and the projected global temperature increase. I concluded that 

optimal ptrp 3% case best fits with the most widely accepted scenario, RCP 4.5. Later, the cost-

benefit analysis with three constant and Ramsey discounting scenarios verified that optimal ptrp 

3% is financially feasible. I demonstrated a welfare function based methodology of determining 

optimal emission control rate, so the future policy makers can set specific emission targets. In 

addition, I conducted CBA showing ptrp 3% scenario is financially feasible. This study would be 

useful in constructing more empirical parameter values for integrated climate projection models. 
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